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1. UVOD  

Za pretvorbu elektromagnetske energije vezane za linije i valovode u prostorni elektromagnetski 

val i obratno, poseže se za aktivnim ili pasivnim elektromagnetskim napravama, antenama. Antene 

s jedne strane vrše funkciju elementa za prilagođenje između linije i slobodnog prostora, a s druge 

strane usmjeravaju zračenu energiju po cijelom prostoru na unaprijed utvrđen način. [1] Za 

djelotvornost te namjene bitno je osigurati antenu u određenom frekvencijskom području koji je 

za tu namjenu potreban. Za ovaj rad bit će opisani opći parametri kojima se opisuju sve vrste 

antena te kako oni utječu na funkcionalnosti i primjenu antena. Parametri antena su karakteristične 

veličine koje opisuju glavna svojstva antene te se ne mijenjaju neovisno prima li antena ili odašilje 

signal. [1] U Ansys HFSS (engl. High Frequency Structure Simulator) računalnom programu bit 

će obrađen model bowtie antene na supstratu, simulirane na frekvencijskom području od 1.8 GHz, 

kakva se koristi u mrežama 4. generacije. Opisat će se kako izgleda model bowtie antene, objasniti 

rezultati parametara dobivenih u Ansys HFSS programu te na temelju njih opisat će se performanse 

bowtie antene, njene prednosti i nedostatci te primjena. 

 

1.1. Zadatak završnog rada 

Cilj završnog rada jest objasniti parametre antena i njihov utjecaj na funkcionalnost antena. 

Teorijski obrađena i simulirana u Ansys HFSS računalnom programu bit će bowtie antena. Model 

bowtie antene bit će izveden na frekvencijskom području od 1.8 GHz te će se simulirati rezultati 

za S11 parametar, VSWR, impedanciju te će se prikazati dijagram zračenja izvedene antene. Na 

simuliranom primjeru će se prokomentirati dobiveni rezultati i performanse bowtie antene. 
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2. Model bowtie antene 

Posljednjih godina, sve veći i brži napredak tehnologije u radiofrekvencijskim sustavima, donio je 

potrebu za napredak u elektroničkim komponentama, računalnim softverima, tehnikama kodiranja 

i antenama. Ako se pogleda široka lepeza bežičnih mreža koja se pojavila, zaključuje se da je 

telekomunikacijsko tržište značajno poraslo od nedavnog napretka u području antena, koje su 

jedna od ključnih točaka komunikacijskih mreža. [2] Antena koja zadovoljava ovakve potrebe, a 

u isto vrijeme zadovoljava potrebe tržišta po pitanju malih dimenzija, niske cijene i kompaktnosti, 

jest bowtie antena kakva će biti analizirana u ovom radu.  

 

2.1. Izgled bowtie antene 

Bowtie antenu karakterizira specifičan izgled prikazan na slici 2.1. Ona nema ravne šipke kao 

elemente, već sadrži elemente trokutastog oblika koji strše s obje strane antene, odakle i dobiva 

naziv s obzirom na to da podsjeća na leptir mašnu ili leptira otvorenih krila, pa se ponekad naziva 

i leptir antena. Dvije polovice ili njena ''krila'' simetrično se šire na obje strane te se gotovo dodiruju 

u sredini antene. [2] 

 

Slika 2.1. Model bowtie antene 
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Dva vodiča (metalne šipke ili žice) raspoređene su simetrično u dipolnoj anteni. Bowtie antena je 

vrsta UHF (engl. Ultra high frequency) širokopojasne dipolne antene. Bowtie antene mogu sličiti 

logaritamskim antenama, ali se ne smatraju logaritamsko-periodičnim antenama. [2] Ultravisoka 

frekvencija (UHF) je oznaka za radiofrekvencije u rasponu između 300 megaherca (MHz) i 3 

gigaherca (GHz), također poznate kao decimetarski pojas jer se valne duljine kreću od jednog 

metra do jednog decimetra. [8] 

 

Bowtie antena smatra se i podvrstom bikonusnih antena, to jest antena širokog pojasa napravljene 

od dva grubo stožasta vodljiva objekta, koji se gotovo dodiruju u svojim točkama, prikazana na 

slici 2.2.  

 

Slika 2.2. Primjer bikonusne antene 
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3. Parametri antena 

3.1. Polarizacija antene 

3.1.1. Vrste polarizacije antena 

Polarizacija antene označava polarizaciju vala koji je izračen iz antene, a određena je krivuljom. 

Krivulju opisuje vrh vektora električnog polja �⃗�  u ravnini okomitoj na smjer širenja vala 

 te se ta krivulja, a tako i polarizacija, može razdijeliti po smjeru u kojem ide. [1] 

Polarizacija se promatra u smjeru maksimalnog zračenja antene i dijeli se na tri vrste prikazane na 

slici 3.1., linearnu koja može ići horizontalno ili vertikalno, kružnu gdje vrh vektora prati kružnicu 

u desnom ili lijevom smjeru. Ovisno o smjeru razlikuje se desna kružna polarizacija (engl. RCP) i 

lijeva kružna polarizacija (engl. LCP). Ako se prati oblik elipse, tada antena ima eliptičnu 

polarizaciju koja se dijeli po smjeru veće osi i smjeru rotacije gledano u smjeru gdje se prostire 

val. Eliptična polarizacija razlikuje se i po aksijalnom odnosu AO. Aksijalni odnos označava omjer 

amplituda polja od 𝐴 do B, iskazano formulom 𝐴𝑂 =
𝐴

𝐵
.      (3-1) 

U slučaju eliptične polarizacije aksijalni odnos označava odnos manje i veće osi elipse. Za kružnu 

polarizaciju 𝐴𝑂 = 1 za linearnu polarizaciju 𝐴𝑂 = ∞. [1] 

 

 

Slika 3.1. Vrste polarizacije 
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Za međusobnu komunikaciju antena potrebno  je da imaju jednaku polarizaciju. 

S obzirom na to da postoje nabrojene različite vrste polarizacija, da se naslutiti da svaka od 

podvrsta ima svoje prednosti i najpovoljniju primjenu u skladu sa svojim svojstvima.  

 

3.1.2. Primjena antena s obzirom na polarizaciju 

Za opće radiokomunikacije koriste se antene s linearnom polarizacijom, budući da se u svrhu 

radiokomunikacijskih aplikacija javlja potreba za jednostavnim i izravnim antenama.  

Linearna polarizacija se također pojavljuje kod antena za bežičnu komunikaciju kratkog dometa, 

poput WiFi-ja. Razlog tome je jednostavnost proizvodnje linearno polariziranih antena u ovim 

uređajima. Za uređaje s dvosmjernom radio komunikacijom, poput radio veza hitnih službi, koristi 

se vertikalna polarizacija. To je zato što mnoge konstrukcije vertikalno polariziranih radijskih 

antena imaju neusmjeren dijagram zračenja. Visokofrekvencijske ionosferske komunikacije na 

daljinu koriste i vertikalnu i horizontalnu polarizacija, iz čega se da zaključiti da su one vrlo 

pogodne i za primjenu na veće distance. Kružna polarizacija često se koristi za satelitske 

radiokomunikacije jer postoje prednosti u pogledu širenja i prevladavanja blijeđenja uzrokovanog 

mijenjanjem orijentacije satelita. [4] 

Svaka od navedenih vrsta polarizacije može se koristiti u razne svrhe i ima svoje prednosti koje se 

mogu iskoristiti za postizanje učinka u posebnim slučajevima, iz tog razloga je važno poznavati 

parametar polarizacije antene kako bi se koristila u prikladnu svrhu. 

 

 

 

  



 

6 

3.2. Dijagram zračenja antene 

Zračenje je izraz koji se koristi za predstavljanje emisije ili prijema fronte vala na anteni, 

specificirajući njenu snagu. [1] Na bilo kojoj ilustraciji, skica koja predstavlja zračenje antene je 

njezin uzorak zračenja. Jednostavno se može razumjeti funkcija i usmjerenost antene ako se 

pogleda njezin uzorak zračenja. Snaga koju zrači antena ima svoj učinak u područjima bliskog i 

dalekog polja. Zračenje se prikazuje putem dijagrama zračenja antene (engl. Antenna radiation 

pattern). 

 

Širenje elektromagnetskih valova može se opisati kao koncentrično zračenje sfernih valova iz 

antene, neovisno o njenom geometrijskom obliku. Takvo koncentrično ili radijalno kretanje 

elektromagnetskih valova uočava se pri određenoj udaljenosti ovisno o modelu antene. 

Dijagram zračenja u takvom prostoru definira se kao raspodjela gustoće snage na površini kugle 

dostatne veličine polumjera. [1] Dijagram zračenja antene može se prikazati u trodimenzionalnom 

obliku te je predstavljen u sfernim koordinatama, a njegovo ishodište nalazi se u središtu sfernog 

koordinatnog sustava. 

 

Slika 3.2. Dijagram zračenja 3D 
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Na slici 3.2. je prikazan dijagram zračenja u 3D. 3D dijagram nam pokazuje intenzitet zračenja 

elektromagnetskih polja koje antena zrači u bilo kojem smjeru. Jačina zračenja je najveća gdje je 

crveno označena površina, a smjer zračenja možemo zamisliti kao vektore koji se pružaju iz 

središta prema van. Iz tog razloga 3D prikaz je vrlo razumljiv za iščitati. Osim jednostavnosti 

prikaza, 3D graf je izuzetno koristan jer daje potpune informacije o dobitku antene i najvažnije, u 

svim mogućim smjerovima.  Iz njega se vidi smjer maksimalnog zračenja te snaga zračenja na 

određenom području. Također neke vrste antena ne zrače jednako u svim smjerovima, već imaju 

latice. Glavna latica je područje najvećeg zračenja, a sekundarne latice mjesta na kojima antena 

zrači, no manjim intenzitetom od glavne. 

Uzorke možemo podijeliti na tri vrste.  Uzorak je "izotropan" ako je uzorak zračenja isti u svim 

smjerovima. Antene s izotropnim uzorcima zračenja ne postoje u praksi, ali se koriste kao 

referentan uzorak i nazivaju se izotropnim radijatorima. Antene također mogu opisati kao 

višesmjerne, što za stvarnu antenu znači da je dijagram zračenja izotropan u jednoj ravnini. Treća 

kategorija antena su "usmjerene", koje nemaju simetriju u dijagramu zračenja. Ove antene obično 

imaju jedan glavni smjer u dijagramu zračenja gdje putuje najveći dio snage. [1] 

 

 

Slika 3.3. Vertikalni dijagram zračenja 2D u XZ ravnini 

 



 

8 

Svojstvo dijagrama zračenja može se prikazati grafički i u 2D obliku. 2D dijagram zračenja 

prikazuje se kao presjek 3D dijagrama, horizontalno (XY ravnina) ili  vertikalno (XZ ravnina). 

Uzorak zračenja na 2D dijagramu karakteriziraju veličine prikazane na Slici 3.3.:  

- kut usmjerenosti Θ𝐷 (engl. HPBW – Half Power Beam Width) koji predstavlja kut oko 

glavnog smjera zračenja unutar kojeg gustoća snage ne pada ispod polovice snage koja se 

zrači u glavnom smjeru zračenja [3] 

- širina snopa Θ𝑛 (engl. BWFN- First Null Beam Width) definirana kao kut između prvih 

nultočaka s jedne i druge strane maksimalnog zračenja [3] 

- faktor potiskivanja sekundarnih latica (s) koji predstavlja odnos između jakosti polja u 

smjeru glavne latice i u smjeru maksimuma najveće sekundarne latice [1] 

 

3.3. Usmjerenost i kut usmjerenosti 

Kut oko glavnog smjera zračenja, unutar kojeg zračena snaga ne pada ispod jedne polovine snage 

koja zrači u smjeru maksimalnog zračenja, naziva se kut usmjerenosti. Smjer maksimalnog 

zračenja odnosi se na smjer u kojem zračeno polje ima maksimalnu amplitudu. [3] 

 

Usmjerenost antene  (engl. Directivity) oznake D je broj koji pokazuje omjer gustoće snage u 

smjeru maksimalnog zračenja i srednje gustoće snage na istoj udaljenosti od antene, prikazano 

izrazom: 𝐷 =
𝑆max

�̅�
           (3-2) 

Gdje je Smax gustoća snage u smjeru maksimalnog smjera zračenja, a 𝑆̅ srednja gustoća snage. 

Putem ovog svojstva vidljivo je koliko puta izračena snaga izotropnog radijatora mora biti veća 

od izračene snage usmjerene antene u smjeru maksimalnog zračenja, kako bi joj na jednakoj 

udaljenosti bila jednaka. [1] 
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3.4. Dobitak 

Dobitak (engl. Gain) ili 'apsolutni dobitak' definiran je kao omjer intenziteta zračenja u određenom 

smjeru prema intenzitetu zračenja koji bi se proizveo da se snaga koju prima antena zrači izotropno 

[6], drugim riječima to je parametar koji govori koliko puta mora biti veća zračena snaga 

izotropnog radijatora u odnosu na dovedenu snagu antene kako bi se na istoj udaljenosti dobila 

ista gustoća snage kao u smjeru maksimalnog zračenja usmjerene antene. Veza između dobitka i 

usmjerenosti antene jest faktor učinkovitosti antene, po formuli:  

g=kD             (3-3) 

Gdje je g – dobitak, k – faktor učinkovitosti antene, a D – usmjerenost. [1] Faktor učinkovitosti 

antene definira se kao omjer izračene snage i snage privedene anteni 𝑘 =
𝑃izračena

𝑃privdena
   (3-4)  

te je pokazatelj koliko se električne energije pretvori u elektromagnetsku energiju. Vrijednost 

faktora učinkovitosti je vrijednost između 0 i 1.  

 

3.5.  S Parametri 

S-parametri (također zvani S-matrica ili parametri raspršenja) predstavljaju linearne karakteristike 

RF elektroničkih sklopova i komponenti [9]. S-parametri opisuju ulazno izlazni odnos između 

priključaka ili terminala u električnom sustavu koji variraju s obzirom na frekvenciju. S sustavi se 

mogu najbolje objasniti preko definirane univerzalne formule SXY, gdje se snaga s X priključka 

prebacuje na Y priključak u mreži s više priključaka. Kada se kaže priključak, to se odnosi na 

mjesto gdje se može isporučiti napon i struja. Tako da parametar S12 predstavlja snagu prenesenu 

s priključka 2 na priključak 1 i obrnuto za S21. Za parametre S11 ili S22, konkretno u nekakvom 

radijskom komunikacijskom sustavu, odnosi se sljedeće: S11 bi tada bila reflektirana snaga koju 

radio odašiljač 1 pokušava isporučiti anteni 1. S22 bi bila reflektirana snaga koju radio odašiljač 2 

pokušava isporučiti anteni 2. A S12 je snaga s radija 2 koja se isporučuje preko antene 1 do radija 

1. [7] 

U praksi s antenama se najčešće bavi parametrom S11 koji će biti modeliran u ovom radu. S11 

predstavlja koliko se snage reflektira od antene i stoga se preko njega opisuju povratni gubitci 

izraženi u decibelima (dB) i uvijek su negativne vrijednosti. 
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3.6. Impedancija antene  

 

Ulazna impedancija antene definira se kao omjer fazora napona i struje na priključnicama antene, 

tj. na dvopolu, koji ovise o frekvenciji elektromagnetskog vala. Impedancija se može iskazati 

izrazom: 𝑍A = 𝑅𝐴 + 𝑗𝑋𝐴 = 𝑅𝑧 + 𝑅𝑑 + 𝑗𝑋A        (3-5) 

Gdje je Ra otpor antene, a Xa reaktivna komponenta impedancije antene. Rzr predstavlja otpor 

zračenja, a Rg otpor gubitaka. [1] 

Impedancija  antene koja se nalazi u slobodnom prostoru predstavlja vlastitu impedanciju antene, 

ako se nalazi daleko od svih drugih objekata. Kada antena zrači snagu, tada generator, na koji je 

ona spojena, tu snagu percipira kao smanjenje i gubitak snage s obzirom na to da je snaga izašla 

iz elektromagnetskog sustava. Taj gubitak snage se može nazvati i otporom zračenja Rz zbog 

percepcije gubitka snage kao zamišljenog otpora. Otpor zračenja može se definirati kao otpor na 

kojem se troši snaga jednaka izračenoj snazi antene, ako je struja kroz taj otpor jednaka struji na 

stezaljkama antene, zapisano formulom: 

 𝑅𝑧 =
𝑃𝑡

𝐼2
  [1].           (3-6) 

Impedancija antene bila bi nula ohma da su napon i struja ostali isti od jedne do druge točke na 

anteni. Međutim, to nikada nije slučaj u stvarnim antenama, koje općenito imaju impedanciju 

negdje između 15 i 1000 ohma. [5] 

Mnogi čimbenici utječu na sposobnost antene da odašilje signal, uključujući okolinu u kojoj se 

antena nalazi te dizajn i sastav antene. Razumijevanje impedancije antene važno je pri 

projektiranju komponenti koje povezuju antenu s prijamnikom ili odašiljačem. 

Za projektiranje antene u određenu svrhu, također je važno imati usklađenu impedanciju. S 

obzirom da antena prenosi signal u nekakav prijemnik, npr. televizijski, taj signal prolazi kroz 

antenu i određene kabele poput koaksijalnog kabela koji prenosi informacije u TV. Takav kabel 

mora biti usklađen u omjeru i napona kako bi impedancija bila usklađena i kako bi na kraju taj 

signal stigao neometen do drugog uređaja. 

 

3.6.1. Smithov dijagram 

Za prikaz impedancije koristi se Smithov dijagram (engl. Smith chart). Smithov dijagram ima 

razne primjene, no njegova primjena važna za radiofrekvencijske sustave, kada se radi o antenama, 

jest što prikazuje stvarne (fizičke) impedancije antene kada se mjeri na vektorskom mrežnom 
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analizatoru. Koristan je kod razumijevanja prijenosnih vodova i njihovog ponašanja sa stajališta 

impedancije te za usklađivanje impedancije. 

 

 

 

Slika 3.4. Usporedba kartezijevog sustava i Smithovog dijagrama 

 

Iako na prvu složenog oblika, Smithov dijagram je tip 2D grafa koji je proizašao iz Kartezijevog 

koordinatnog sustava. Slika 3.4. pokazuje Kartezijev sustav i Smithov dijagram te je vidljivo kako 

je Smithov dijagram nastao iz prikaza savijenog pravokutnog sustava.  Za jednostavnije shvaćanje 

prikaza impedancije sa Smithovog grafa, može se usporediti njen prikaz iz kartezijevog sustava. 

Ako se kompleksna impedancija Z pogleda kroz koordinatni sustav, u ovom slučaju sustav 

označen s R i X koordinatom (ili uobičajeno X i Y koordinate) koje ovdje prikazuju osi reaktancije, 

tj. induktivnog otpora, vidljivo je da se ona sastoji od čisto otporničkog dijela R koji se ne mijenja 

s frekvencijom i reaktantnog dijela X na koji utječe frekvencija. Reaktancija može biti induktivna, 

označeno crveno ili kapacitetna, označeno plavo. Prenoseći ovu logiku na Smithov dijagram 

dobiva se sljedeće, gornja polovica koja označava osi reaktancije +X i donju -X.  

Iako su oba 2D grafa na kojem se može prikazati impedancija, Smithov dijagram je u tu svrhu 

puno povoljniji. Za prikazivanje impedancije ne koristi se kartezijev koordinatni zato što će se 

koristiti samo desna strana sustava, jer je otpor uvijek pozitivan. Drugi i jednako važan razlog iz 

kojeg se Kartezijev sustav ne koristi je taj što impedancija i otpor imaju raspon od 0 do plus ili 
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minus beskonačno. Dakle, može se zaključiti da se oba načina mogu koristiti u svrhu prikaza 

impedancije, ali Smithov dijagram daje povoljniji prikaz. 

Impedanciju označavamo kao krivulju u Smithovom dijagramu, a uređaj je rezonantan na 

frekvenciji na kojoj se linija kreće kroz središte. Središte Smithovog grafa se nalazi na 1.0, za 

razliku od koordinatnog sustava. 

 

3.7. VSWR 

Uobičajena mjera koja pokazuje koliko je antena dobro usklađena s prijamnikom poznata je kao 

omjer stojnog vala napona ili VSWR (engl. Voltage Standing Wave Ratio). VSWR je stvarni broj 

koji je uvijek veći ili jednak jedan. VSWR od jedan ukazuje na to da nema gubitka neusklađenosti 

nego je antena savršeno usklađena s linijom prijenosa. Više vrijednosti VSWR-a ukazuju na veći 

gubitak neusklađenosti.[1] VSWR se može iskazati formulom:  

𝑟 = 𝑉𝑆𝑊𝑅 =
|𝑈|𝑚𝑎𝑥 

|U|min 
 ≥ 1.          (3-7) 

Izraz predstavlja odnos vršne vrijednosti amplitude stojnog vala i njegove minimalne vrijednosti, 

što znači ako je manja vrijednost VSWR, antena je bolje prilagođena i više snage je poslano u 

prostor. [1] 

Da bi radio odašiljač isporučivao energiju anteni ili prijemnik zaprimio, impedancija radija i 

prijenosne linije mora biti dobro usklađena s impedancijom antene. 
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4.  Izrada bowtie antene u ANSYS HFSS programu 

Nakon što se razumiju funkcionalnosti antena te kako su s njima povezani parametri koji određuju 

antene, mogu se prokomentirati glavni parametri bikonusne bowtie antene koji će se prikazati u 

Ansys HFSS programu. 

Računalni programi za simulacije služe za predviđanje i prikaz antena te njihovih tehničkih 

mogućnosti. Ansys HFSS omogućava simulaciju rezultata odabranih parametara antene, prikaz 

parametara u različitim vrstama grafova (2D, 3D, Smithov dijagram i sl.) te simulaciju drugih 

funkcionalnosti antena koje oponašaju korištenje stvarnom svijetu. Za istraživanje antena 

najzanimljivija mogućnost kod simulacija je predikcija performansi antena. Na taj način se može 

predvidjeti kako će antena funkcionirati u stvarnom svijetu, hoće li biti dovoljno učinkovita za 

svrhu za koju se predviđa te kako će na njene performanse utjecati eventualni vanjski utjecaji. 

Program koji se koristio je Ansys HFSS 2022 R2, koji je višenamjenski softver za 3D 

elektromagnetsku simulaciju punog i projektiranje visokofrekvencijskih elektroničkih proizvoda 

kao što su antene, komponente, konektori, IC (engl. integrated circuit) i PCB (engl. printed circuit 

board).  

 

Za izvedbu u Ansys HFSS programu odabrana je bowtie antena na supstratu predviđena za rad na 

frekvenciji od 1.8 GHz. Prikazat će se izrada modela u detaljnim koracima, kako bi čitatelj slijedeći 

upute mogao izraditi isti model, ukoliko želi. Prikazat će se i koraci za dobivanje rezultata, a bit 

će određen parametar S11, VSWR, prikaz impedancije u Smithovom dijagramu te dijagram 

zračenja antene. 
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4.1. Izrada modela bowtie antene 

Prvi korak je definiranje frekvencije na kojoj će antena raditi, o tom podatku ovise dimenzije 

antene. Odabrana frekvencija za bowtie antenu je 1.8GHz. U Ansys HFSS programu ugrađen je 

čarobnjak (engl. Wizard) za izračun dimenzija antena. Nakon pokretanja Ansys HFSS programa, 

čarobnjak se pokreće klikom na View → ACT Extensions→ HFSS Antenna Toolkit. Nakon što je 

otvoren čarobnjak, potrebno je odabrati tip antene, u ovom slučaju, odabire se Bowtie Antenna, 

upisuje se frekvencija od 1.8GHz kao na slici 4.1. U padajućem izborniku Outer Boundary 

potrebno je odabrati Radiation. Za podlogu bowtie antene odabran je supstrat (dielektrik), model 

FR4_epoxy, epoksidni materijal ojačan staklom koji daje zadovoljavajuće rezultate pri korištenju 

s bowtie i mikrotrakastim antenama (engl. Patch antenna). Nakon unosa navedenih podataka, 

klikne se na gumb Synthesis te se tada dobiju potrebne dimenzije prikazane na slici 4.1. Putem 

čarobnjaka je moguće da program sam izradi antenu, no takav model nudi manje precizno rješenje, 

s manjim mogućnostima modeliranja, stoga će se antena raditi ručno. Nakon ovog koraka može se 

ugasiti prozor čarobnjaka. 

Slika 4.1. HFSS čarobnjak za izračun dimenzija antene 
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Za kreiranje projekta u alatnoj traci odabire se File →New te nakon toga, u gornjoj alatnoj traci 

odabrati HFSS. Nakon otvaranja praznog projekta, odabire se vrsta rješenja u stablu Project 

Managera na slici 4.2. desnim klikom na HFSSDesign → Solution Type i odabirom Modal te 

potvrdom s OK. 

 

Slika 4.2. Stablo Project manager i njegov izbornik 

 Odabrano modalno rješenje rješava matrice na temelju snage, dajući preciznije rezultate, a 

terminalno rješenje se temelji na naponu i struji. Prazan projekt je sada spreman za dodavanje 

potrebnih objekata. 

Prvi izrađeni objekt bit će podloga (supstrat). Klikom na Draw Box otvara se mogućnost crtanja 

kvadra u području za crtanje. Potrebno je nacrtati kvadar na proizvoljnom mjestu i proizvoljne 

veličine. Nakon što se pojavio novi model Box1, dvostrukim klikom na njega otvaraju se svojstva 

odabranog modela. U svojstvima postaviti materijal "FR4_epoxy" te mu dodati proizvoljno ime i 

boju, a za bolju preglednost potrebno je postaviti prozirnost na 0.88 kao na slici 4.3. 
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Slika 4.3. Postavke supstrata 

Za uređivanje veličine i položaja dvostrukim klikom na CreateBox otvaraju se postavke dimenzija 

te je potrebno upisati veličine sa slike 4.4.  

 

Slika 4.4. Postavke dimenzija i položaja supstrata 

Debljina supstrata pod imenom ZSize postavljena je na 2.3mm što je deblje nego od sugeriranog, 

jer je pri ispitivanju zamijećeno da debljina supstrata od 2.3mm daje bolje ugođene rezultate od 

preporučene 1.575mm. Supstrat je ovim korakom dovršen i izgleda kao na slici 4.5. 
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Slika 4.5. Prikaz izrađenog supstrata 

Nakon izrade supstrata izvedba bowtie antene započet će se iscrtavanjem proreza ili Porta između 

dvije strane, koje će se nalaziti u središtu prostora za crtanje. Prvi korak je klik na Draw rectangle 

te se opet iscrta proizvoljni pravokutnik. Dvostrukim klikom na CreateRectangle otvaraju se 

svojstva dimenzija pravokutnika i upisuju dimenzije sa slike 4.6. 

 

Slika 4.6. Postavke dimenzija i položaja Porta 

Elementi koji čine bowtie antenu, dva vodiča od bakrenog materijala, bit će u sljedećem tekstu 

nazvani granama antena, radi jednostavnosti uputa. 
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Za dodavanje prve grane bowtie antene potrebno je odabrati naredbu Draw line, iscrtati 

četverokutnik oblika kao sa slike 4.11. te upisati dimenzije klikom na CreateLine sa sljedećim 

dimenzijama: linija koja se nalazi do porta - slika 4.7., veća linija paralelna s njom - slika 4.8., 

gornja njima okomita linija - slika 4.9. te posljednja donja linija - slika 4.10.  

 

Slika 4.7. Položaj i dimenzije linije koja se nalazi do porta 

 

Slika 4.8. Položaj i dimenzije veće linije paralelne s linijom do porta 

 

Slika 4.9. Položaj i dimenzije gornje linije okomite prvoj i drugoj iscrtanoj liniji 

 

Slika 4.10. Položaj i dimenzije donje linije okomite prvoj i drugoj iscrtanoj liniji 
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Slika 4.11. Model nakon iscrtavanja prve grane 

Model sada izgleda kao na slici 4.11.  

Lijevim klikom odabire se novonastali model Polyline te se u gornjoj alatnoj traci odabire opcija 

Duplicate around axis. Postavljaju se svojstva kao na slici 4.12. te nakon dupliciranja, može se 

obrisati nepotrebna grana desnim klikom na njen model Edit→Delete. Model sada treba izgledati 

kao na slici 19. 

 

Slika 4.12. Postavke dupliciranja grane antene 
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Slika 4.13. Iscrtani model nakon dupliciranja grane antene 

 

Nakon iscrtavanja modela potrebno je označiti materijal grana antene te dovesti napajanje. 

Dodavanje materijala granama postiže se označavanjem obje grane te se desnim klikom otvara 

izbornik u kojem se odabire Assign Boundary→Perfect E prikazano na slici 4.15. Perfect E će 

simulirati materijal bakar. 
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Slika 4.14. Koraci dodavanja materijala granama 

Port će simulirati unutarnje napajanje (pobudu) za dipol antene. Portu će se dodijeliti impedancija 

od 50 Ω koja simulira koaksijalni 50-omski kabel. Desni klik otvara izbornik u kojem se odabire 

Assign Excitation → Port → Lumped port te upisati 50 Ω kao na slici 4.16. 

 

Slika 4.15. Postavke napajanja porta 
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Na sljedećem koraku gdje je potrebno odabrati Integration line, tj. liniju koja spaja dvije grane 

antene, kliknuti na New line i povući crtu od jedne grane do druge, kao na slici 4.17.

  

Slika 4.16. Prikaz povučene integracijske linije s lijeva na desno 

Na posljednjem koraku ovog prozora odabrati Renormalize All i upisati 50 Ω. 

Za zadnji korak izrade modela potrebno je označiti područje zračenja, odabirom naredbe Draw 

box, proizvoljnim iscrtavanjem te dodavanjem dimenzija sa slike 4.18. po uzoru na prethodne 

korake. Desnim klikom na novonastali objekti iz izbornika odabrati Assign Boundary→Radiation 

te potvrditi s OK. Ako materijal automatski nije postavljen na vakuum, isto promijeniti u 

postavkama. Krajnji model izgleda kao na slici 4.19. 

 

Slika 4.17. Postavke dimenzija i položaja područja zračenja 
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Slika 4.18. Završeni model bowtie antene 

 

4.2. Postavljanje parametara analize u Ansys HFSS 

Prije simulacije potrebno je postaviti za koje frekvencijsko područje će se provoditi analiza 

parametara antene. Desnim klikom na gumb Analysis koji se nalazi u stablu Project Managera, 

otvara se izbornik u kojem se odabire Add Solution Setup. U otvorenom prozoru potrebno je upisati 

1.8GHz za frekvenciju, a pod Maximum Number of Passes upisati 30. Nakon što je kreiran Setup 

desnim klikom na njega još izabrati Add Frequency Sweep i upisati parametre po uzoru na sliku 

4.20. 

 

Slika 4.19. Postavke frekvencijskog područja 
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4.3. Postavljanje parametara za dijagram zračenja  

Za zadnji korak postavki analize, potrebno je postaviti parametre za dobivanje 3D dijagrama 

zračenja. Desnim klikom na Radiation odabire se Insert far field setup→Infinite sphere te se 

postavljaju parametri kao na slici 4.21. 

 

Slika 4.20. Postavke parametara za 3D prikaz dijagram zračenja 
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5. Prikaz parametara bowtie antene u Ansys HFSS programu 

Nakon izrade modela i postavljanja postavki za analizu, potrebno je u gornjoj alatnoj traci kliknuti 

na HFSS→Validation check kako bi se provjerile komponente izrađenog modela modela te ako 

su objekti u redu. Kliknuti na Analyse All što pokreće analizu rezultata u pozadini. 

 

5.1. S11 parametar prikazane bowtie antene 

Prvi simulirani parametar S11 dobiva se desnim klikom na Results u Project manageru, zatim 

Create modal solution data report → Rectangular plot te je na kraju potrebno odabrati S11 

parametar po uzoru na sliku 5.1. 

 

Slika 5.1. Koraci za simuliranje rezultata S11 parametra 
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Slika 5.2. S11 parametar izvedene bowtie antene 

 

Prikaz S11 parametra vidljiv je na slici 5.2. Na parametru S11 promatra se širina frekvencijskog 

pojasa, uzimajući u obzir frekvenciju gdje je S11, tj. koeficijent refleksije ispod -10dB. Širina pojasa 

se pruža od 1.57GHz do 2.05GHz, a najmanje snage reflektira se na 1.78GHz gdje S11 iznosi -

22.06dB. Ovakav rezultat je poželjan te pokazuje da se reflektira malo snage od antene nazad 

prema izvoru. 
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5.2. VSWR parametar prikazane bowtie antene 

Parametar VSWR simulira se po uzoru na parametar S11 te promjenom kategorije umjesto S11 na 

VSWR. 

 

 

Slika 5.3. VSWR parametar izvedene bowtie antene 

 

VSWR parametar prikazan je na slici 5.3. Idealan rezultat VSWR-a bio bi jednak 1, a prihvatljiv 

da je manji od 3. Za izrađenu bowtie antenu VSWR iznosi 1.2 što predstavlja dobar rezultat. 
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5.3. Smithov dijagram impedancije prikazane bowtie antene  

Patch antene obično imaju ulazne impedancije na rubovima od 100 ili više ohma, ako se u tom 

slučaju koristi pobude od 50 Ω, potreban je  λ/4 (četvrtvalni) inverter za transformaciju od 50 Ω u 

potrebnu ulaznu impedanciju. Transformacija se simulira renormalizacijom impedancije porta na 

vrijednost između 100-150 Ω. Za ovaj slučaj renormalizira se na 120 Ω za prikaz rezultata 

impedancije na Smithovom dijagramu. 

Smithov dijagram dobiva se odabirom Create modal solution data report → Smith Chart→S11. 

 

Slika 5.4. Smithov dijagram izvedene bowtie antene 

Na slici 5.4. prikazan je rezultat impedancije na Smithovom dijagramu. Na frekvencijskom 

području od 1.82GHz realni dio iznosi 50.41, a imaginarni 1.05i, tj. rezultat impedancije iznosi 

50.41Ω + j1.05Ω. Rezultat kojem se teži je 50Ω + j 0 Ω i predstavlja potpuno prilagođenje, u 

sučaju bowtie antene dio energije se reflektira nazad prema izvoru. 
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5.4. Dijagram zračenja bowtie antene 

3D dijagram se dobiva klikom na Results→Create far fields report→3D polar plot te se upisuju 

parametri kao na slici 5.5.  

 

Slika 5.5. Parametri za simulaciju zračenja u 3D 
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Slika 5.6. 3D dijagram zračenja izvedene bowtie antene 

Na slici 5.6. je prikazan trodimenzionalni uzorak zračenja simulirane bowtie antene sastavljen od 

tri koordinate (x, y, z), iskazan u decibelima. 

Simulirana antena je primjer uzorka zračenja u obliku krofne ili toroidalnog oblika.  

Simulirana bowtie antena jednoličnom snagom zrači u smjeru prema van te nema bočnih režnjeva 

ili drugih različitosti u zračenju. U ovom slučaju, duž Y-osi, koja bi odgovarala zračenju u sredini 

antene, prenosi se vrlo mala snaga. U ravnini X-Z (okomito na os Y) zračenje je maksimalno. To 

znači da njeno zračenje pokriva jednoličnu površinu, bez većih promjena intenziteta snage u 

nekom smjeru. Dakle, ova antena se može okarakterizirati kao više smjerna i iz tog razloga je 

pogodna za korištenje u slučajevima kada je potrebno pokriti određeno područje simetrično u svim 

smjerovima, poput radara, Bluetootha i sl. 

Ovakva polarizacija se naziva cirkularna te je karakteristika višesmjernih antena, koje inače mogu 

biti i okomito polarizirane. Cirkularno polarizirana višesmjerna antena ima posebno učinkovite 

performanse zato što je neosjetljiva na orijentaciju vala. 
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6. Prednosti i nedostaci bowtie antene s obzirom na rezultate 

6.1. Prednosti i nedostaci bowtie antene 

U prošlim poglavljima istražena su svojstva simulirane bowtie antene. Za bowtie antenu se može 

reći da posjeduje skup strogih antenskih performansi kao što su niska frekvencija rada, 

ultraširokopojasna izvedba, kompaktnost te lakoća rada. 

Može preporučiti i korištenje FR4_epoxy supstrata za razvoj jeftinih, laganih antena za "all-

package" rješenja za buduće bežične komunikacije i sustave daljinskog očitavanja. 

Kako Zentner objašnjava, antene kod bežičnih sustava predstavljaju jedan od najbitnijih segmenata 

te ako je potrebno proširiti domet signala, potrebno je odabrati dobru vanjsku antenu s odličnim 

dobitkom i direkcionalnim ili omnidirekcionalnim svojstvima [1]. Ovdje prikazani rezultati 

pokazuju primjenjivost bowtie antena kada dolazi do potrebe za razvojem jeftinih, laganih antena 

manjih dimenzija koje zrače u svim smjerovima. 

Kao nedostatak može se navesti da pokazuje slabu učinkovitost odašiljanja na frekvencijama na 

niskom kraju svog raspona, što rezultira nižom jakošću polja u usporedbi s ulaznom snagom. 

6.2. Primjena bowtie antena 

Bowtie antene zbog svoje praktične prirode, imaju raznoliku mogućnost primjene. Kao što je već 

navedeno najčešća primjena je kod malih uređaja u kućanstvu koji koriste tehnologije poput 

Bluetootha, WiFi-ja i dr. No, bowtie antena prigodna je i za kompleksnije primjene poput prijenosa 

satelitskog signala ili u svrhu radara. Primjer takvog korištenja bio bi geometrijski radar (GPR), 

posebna vrsta radara koji koristi elektromagnetske valove za otkrivanje zakopanih objekata u 

plitkom sloju zemlje. 
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7. Zaključak 

Kada bismo slučajnog korisnika upitali, zna li što su to antene i čemu služe, većina ljudi bi 

odgovorila pozitivno te bi znali objasniti svojim riječima čemu ona služi, dok bi neki od njih i 

stručno odgovorili da su antene uređaji koji omogućavaju pretvorbu elektromagnetske energije te 

širenje elektromagnetskog vala prostorom [1]. Opće poznavanje antena je rezultat tome što se 

većina ljudi se susrela s nekakvim tipom antena, bilo to antena s WiFi rutera, sobna TV antena, 

satelitska antena postavljena na kući ili sl.  

S obzirom na puno različitih primjena antena, nameće se zaključak da ne postoji jedna vrsta antene 

te da nije svaka vrsta pogodna za svaku namjenu. 

Kada bi proizvođač antena dobio narudžbu da izradi antenu za određenu primjenu, također bi prvo 

postavio pitanje naručitelju, koja je željena frekvencija, dobitak, impedancija i polarizacija? To su 

samo neki od parametara koji određuju svojstva antene te njenu funkcionalnost. Ovisno o tim 

parametrima, određuje se primjena antene. Na primjer u male uređaje za radio komunikaciju će se 

postavljati jednostavne i jeftine antene s linearnom polarizacijom, dok ćemo za bežičnu 

komunikaciju s nešto većim zahtjevima na snagu, trebati bowtie antenu na supstratu s kružnim 

širenjem signala. 

Takav model simuliran je u ovom radu. Njena jednostavnost čini ju poželjnom za masovnu izradu, 

a zadovoljavajuć dobitak, mali gubitci i zračenje u svim smjerovima, dodaju prednost omjeru 

njenog učinka i povoljnosti izrade. Iz tog razloga, sve veća potražnja za manjim i fleksibilnim 

antenama s vertikalnom, a posebno kružnom polarizacijom čini bowtie antenu vrlo poželjnu za 

svakodnevno korištenje u bežičnim komunikacijama, tv signalu i drugim sličnim primjenama. 

Osim rezultata koji su se pokazali kao više nego dobri za manje antene u kućnoj upotrebi, Tv signal 

ili WiFi, bowtie antene s kružnom polarizacijom mogu biti pogodne i za veće zahtjeve poput 

komunikacija na većim geografskim širinama, za satelitsku komunikaciju i drugo. U tom slučaju 

osnovni model ipak ne bi bio dovoljan te bi trebalo posebno dizajnirati i eventualno dodati 

potrebne objekte za pojačanje zračenja, efikasnosti i dometa. 

Kada bi bila takva potreba za daljnja detaljnija eksperimentalna istraživanja trebalo bi se ispitati 

kako se bowtie antene ponašaju pri određenim vanjskim uvjetima, s i bez pojačivača,  kako na njih 

utječu različiti materijali i slično.
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Sažetak 

U završnom radu, opisana su glavna svojstva koja određuju antenu. Objašnjeno je kako vrsta 

antene i njeni parametri utječu na njenu primjenu. Teorijski je obrađena podvrsta bikonusnih 

antena, bowtie antena. Također je simuliran model bowtie antene te su prokomentirani dobiveni 

rezultati i na temelju njih su iznijete njene prednosti i nedostatci, ovisno o svrsi u koju se koristi. 

Ključne riječi: antena, bowtie, parametri, simulacija 
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Abstract  

In the final paper, the main properties that determine the antenna are described. It is explained how 

the type of antenna and its parameters affect its application. A subtype of biconical antennas, 

bowtie antennas, is theoretically treated. A bowtie antenna model was also simulated and the 

obtained results were commented on, and based on them, its advantages and disadvantages were 

presented, depending on the purpose for which it is used. 

Keywords: antenna, bowtie, parameters, simulation 
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